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Why Map Your Community?
by Bob Coulter

This booklet contains a series of tutorials with tips and techniques on how to use ArcGIS to map your 
local community. In these opening pages I hope to put the remainder of the booklet in context by 
addressing the more fundamental question of why it is a good idea to map your community. I will 
suggest that there are two fundamental, inter-related reasons. Quite simply, people should map their 
community to:

place themselves on the map, helping to build a sense of place in the world, and•	

place local issues on the map, enabling better investigation and analysis. •	

Over the past 15 years I’ve worked with students who have conducted investigations of local issues such 
as water quality in a neighborhood creek, the potential environmental consequences of a new baseball 
stadium, and patterns in racial and economic segregation. Each of these projects and many like it have 
provided opportunities for students to deepen their understanding of the world and how it works, 
starting with a local phenomenon that was important to them. It’s much easier to develop enthusiasm 
for a topic you can see every day than it is for an abstraction in a textbook. The local creek filled with 
critters is a much better “draw” for students’ interest than a picture of a creek somewhere else.

Aside from these broader educational reasons, there is also a more pragmatic reason to consider: 
Rich investigations such as these create the space in which your students can practice a range of skills 
that feature prominently on standardized tests, including math skills with number operations and 
data analysis as well as language skills used for interpreting evidence and drawing conclusions. Many 
aspects of the emerging “Common Core” standards in math and language, as well as the Science 
Frameworks advanced by the National Academies of Science can be addressed through GIS-enhanced 
projects.

Note also that while the projects described here sound sophisticated, they are accessible to younger 
students. With the right motivation—often provided by the local context—students bring a lot more 
sophistication to their work than they might for something that is seen as “just a school assignment.” 
With the right guidance, comparatively young students are capable of sustained and meaningful 
analysis. Together, students’ motivation nurtured by your guidance  can create magical learning 
experiences. 

To help you along the way, the tutorials offered here are intended to help you and your students focus 
on the issues being investigated without having to get buried in learning all of the tools ArcGIS offers. 
The tools highlighted here are the ones I’ve found most useful in more than a decade of supporting 
local projects, dating back to the days of ArcView 3. If you think others might be useful, drop me a 
note at bob@lrec.net. Your idea might make it in an updated version. Also, as ArcGIS evolves, this 
booklet will be updated to remain current. (This is already its third iteration, following on earlier 
versions for ArcGIS 8 and 9).

And now, on to the business at hand: Why map your community?

mailto:bob@lrec.net
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Goal #1: Putting Yourself on the Map
There seems to be something almost instinctual when kids see a map: they want to place themselves 
on it. Where do I live? What’s near me? Where is my friend’s house? Developmentally speaking, David 
Sobel (1998) has shown a developmental trajectory for young students, starting with representations 
of home and moving out into the neighborhood. It seems that we never lose our fascination with 
home, though, as a place to anchor ourselves. Looking more broadly, basing our learning in the 
local community serves a similar “homing” function, providing the springboard from which we can 
learn about the world. While there is no doubt that we live in an increasingly global world, a range 
of research assembled by the Place-based Education Evaluation Collaborative (PEEC) shows that 
students benefit from starting with what is immediately familiar. In particular, when students have 
opportunities to engage in locally-based studies when they can measure and monitor their impact 
have proven to be particularly valuable in promoting depth and motivation among young learners 
(Duffin, Murphy, and Johnson, 2008). 

Given these educational benefits, a number of educators are becoming more interested in place-based 
approaches to education. As noted by PEEC (2010):

Place based education immerses students in local heritage, culture, ecology, landscapes, •	
opportunities and experiences as a foundation for the study of language arts, mathematics, 
social studies, science, and other subjects. 

Place based education encourages teachers and students to use the schoolyard, community, •	
public lands, and other special places as resources, turning communities into classrooms.

Project-focused and inherently tailored by local people to local realities, place-based educa-•	
tion is equally relevant in small towns and big cities, equally effective for kindergarteners and 
high school students.

A good place to start with place-based projects is a map of the local area. The tools and techniques 
described here can help you get started in building curriculum resources that bring local mapping to 
your classroom.  

Goal #2: Putting Issues on the Map
Aside from that first step of putting yourself on the map, there is a lot of benefit to be had in mapping 
local issues. A continuum I’ve found helpful is to think of kids studying water quality. All too many 
students simply read about water quality in their textbook, perhaps with the posed picture of a 
scientist looking at a water sample. One step further, students can conduct hands-on testing of water 
samples with simple tools like thermometers and pH paper. A third step would be to go outside 
and get the benefit of actual field experience: What is the water like in the creek that runs by the 
playground? Each step adds complexity and authenticity to the students’ work. 

As important as these steps are, I encourage you to take the next step, which is to add a spatial 
component to your investigations. How does the water quality here compare with the water down 
stream? What factors might explain the difference? One of my first geospatial projects with students 
(Coulter, 2000) involved fifth graders who wanted to map local water quality for a science fair project. 
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They tested at four different locations over the course of four months using a variety of chemical 
tests and electronic probes. In the end, they found that water quality suffered a “dip” in a highly 
industrialized area with several limestone operations (thus accounting for the pH increase) and an 
area with exposed soil banks and a denser road network (both of which accounted for their measured 
uptick in the level of solids in the water through erosion and runoff).  

A few years later one of these students returned to GIS as he completed a required environmental 
analysis project for his 8th grade Earth science class. At the time, there was a great deal of local 
interest in the possibility of the St Louis Cardinals building a new baseball stadium. Using GIS, 
Nathan investigated a number of relevant environmental issues, including whether the new stadium 
would encroach on a flood plain and whether the soil type and underlying geology would be suitable. 
He also used historic land use data to identify a possible concern, as the new stadium site had 
previously been used as a gas station. As it turned out, the stadium was built, and a few years later an 
issue appeared briefly in the local papers as to whether there was a soil pollution problem at the new 
stadium. Nathan beat them to the story!

Aside from supporting these individual projects, teachers can leverage high interest events to support 
rich inquiry. Living in the midwest, tornados are an all too common occurrence. Three times I’ve had 
occasions to support tornado-based GIS projects. This can be done at a relative micro-scale plotting 
paths of individual tornado strikes such as the one that hit Lambert St. Louis Airport in April 2011, or 
on a larger scale as students look for broad patterns. On New Year’s Eve 2010 we had a highly unusual 
winter tornado strike, which kicked off an investigation by middle school students of how tornados 
in Missouri vary seasonally. Each of these projects used a high interest event to make otherwise dry 
Earth science content come to life. Teachers, armed with geospatial tools, turned the news into an 
investigation. 

Lest you think GIS is all about science, you can use GIS to investigate a number of social issues as 
well. Back in 2008 I had the privilege of working with Molly, a 6th grader at a local elementary school. 
She wanted to investigate change in her suburban St Louis community in the fifty years since her 
grandfather moved there. Using ArcGIS and historic Census data from NHGIS (nhgis.org), Molly 
mapped racial change since 1960 and crafted a series of maps that captured her community’s current 
socio-economic divide. She then proudly presented it to an audience of thousands of geospatial 
professionals at the ESRI annual conference. 

Where can your students go with GIS?

Goal #3: Deepening Academic Skills With GIS
If you have read this far, you are probably willing to grant that using GIS has the potential to be 
a powerful learning tool. Still, you may be asking yourself if you can do this and still meet your 
curriculum requirements. To respond, I encourage you to consider the learning embedded in 
the examples cited above. A range of Earth and social science  concepts came to the fore, and 
mathematics skills were developed as students collected and analyzed relevant data. Along with 
this, students practiced language skills as they communicated with local experts, conducted online 
research, discussed their findings, and generated conclusions. 
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Fortunately, geospatial projects align well with the new Frameworks for Science Education 
promulgated by the National Academies of Science as well as the Common Core standards in 
mathematics and language arts. You don’t need to choose between rich local learning projects and 
meeting curriculum standards. With creative design, you can have both. The following chart shows 
a few examples of how you can address emerging science and mathematics standards with GIS. Your 
students will also develop a range of language skills as the investigate issues, conduct background 
research, and communicate their findings. 

Common Core Standards for Mathematical Practice

Make sense of problems and persevere in solving them.•	

Construct viable arguments and critique the reasoning of others•	

Model with mathematics•	

Use appropriate tools strategically•	

Attend to precision•	

Look for and make use of structure•	

Look for and express regularity in repeated reasoning•	

National Academies of Science Frameworks—Scientific Practices

Asking questions and defining problems•	

Developing and using models•	

Planning and carrying out investigations•	

Analyzing and interpreting data•	

Using mathematics and computational thinking•	

Constructing explanations•	

Engaging in argument from evidence•	

Obtaining, evaluating, and communicating information•	

In my experience the key to a successful project is to build students’ enthusiasm and motivation to 
investigate real-world issues that have a local connection, and to provide the guidance needed to 
help them succeed. As the teacher, you are the architect or designer of their learning experiences. I 
hope that these tutorials help you to navigate through the menus and buttons so you can focus on the 
learning. To help you get started, the table below gives an overview of each tutorial
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Section Focus What’s it Good For?

1.1 Getting Started The basics of starting ArcGIS and mapping data.

1.2 Adjusting your view Zooming in and out to refine your view of the data.
1.3 Editing the legend Mastering the legend gives you control over how your data is 

presented. Learn editing tips here.
2.1 Joining data tables Often, you’ll find a data table (such as per capita income for each 

county in a state) and want to map it. Start here to learn how to 
plot that data on your map.

2.2 Managing .e00 files While .e00 (or coverage) files are an older “legacy” format, much 
local data still uses it. This section will help you to manage the 
data efficiently. 

2.3 Importing imagery How to bring aerial photography into your projects.
3.1 Defining map 

projections
Geographers use different projections to suit their purposes. For 
the most part ArcGIS can work with these different projections. 
When it can’t, look here. 

3.2 Clipping data layers How to have just a portion of a larger data layer—perhaps your 
city’s roads from a county road layer.

3.3 Merging data layers The opposite of the previous task. In this one, combine two layers 
to make a larger one. Imagine you need the creek layers from a 
couple of adjacent counties to map a watershed. 

4.4 Plotting single 
addresses on a map

Tips for plotting a single location like your school on a map.

4.2 Plotting multiple 
addresses on a map

Ways to plot a set of addresses (like store locations) easily.

4.3 Plotting GPS 
coordinates on a map

Ways to plot data for which you have collected latitude and 
longitude data, such as creek monitoring locations.

4.4 Combining imagery 
and coordinates

How to have your locations plotted on an aerial photograph of 
your study site
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Section 1: 	Introduction to ArcGIS® 10

A main component of ArcGIS® 10 software is ArcMap.  It can be used to create and edit maps and 
analyze spatial data.

1.1	G etting Started

Start ArcMap.  If you do not have an ArcMap icon on your desktop or in your Windows “Start” menu, 
you can locate ArcMap from the Start Menu:

Click on the “Start” menu symbol in the lower left corner of your screen.1)	

Choose “Programs” or “All Programs”.2)	

Choose “ArcGIS”.3)	

Choose “ArcMap”.4)	
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In the dialog box that appears, choose to make a new blank map and then click “OK”:

Adding data
There are a couple of ways to add data.  You can click on the “Add Data” button ( ), navigate to 
where your file is stored, click on the file you want to use, and then click “Add”.  
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Or you can use the Catalog.  Click on the Catalog tab at the right side of the screen to open it. (If you 
do not see the Catalog tab, click on the menu option “Windows” and then click on “Catalog.”) 

First, you will have to set up the catalog to include your data files. In the Catalog window right-click 
on Folder Connections...”, then click on “Connect Folder...”  Navigate to where your data files are 
stored. and then click “Ok.”

Note: use the menu pin in the upper right corner of the Catalog window to set your Catalog to retract 
or to pin it open.  A pin facing left lets the Catalog automatically retract; it will reopen when you you 
hover your mouse over the Catalog tab.  A pin facing down keeps the Catalog open.

Once your Folder Connections are set up, you can drag and drop files from the Catalog into your 
data frame. Adding the “US_STATES” file adds a data layer representing the United States with state 
boundaries.
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Before we go further, notice a few things on your screen: 

When working with map layers, the part of the screen in which the layers are drawn is called the 1)	
data frame. 

The column to the left of the data frame, which shows a list of your data layers, is called the 2)	 Table 
of Contents.

The Table of Contents can list the map layers in your project in different ways. You can switch 3)	
modes by clicking on the buttons at the top of the Table of Contents. We will be using the “List by 
Drawing Order” mode.

Next to each layer name there is a small check box. If you click it, the layer will turn on or off. You 4)	
can use this to display (or not display) an individual layer.

To the left of that check box, there is a smaller box showing a + or - character. This controls the 5)	
display of the color coding or “symbology”.  (Working with symbology will be covered in Lesson 
1.3: Editing the Legend.)  If the - character is displayed, the color coding (“symbology”) is already 
shown—in this case pink with a black border. If you want to compact your Table of Contents, you 
can turn this off by clicking on the - , which will hide the symbology.  Click on the + to display the 
symbology again.

3

4
5

12
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Adding more data
Drag and drop more files from the Catalog to add more layers to your map. Here we’ve added two 
more layers: “US_CITIES” and “US_COUNTIES”:

Changing the “stack” order
Notice that the software “stacks” the data layers in the map in the same order in which they are listed 
in the Table of Contents. Sometimes one layer will completely cover another. For example, in the map 
above, the US counties are covering the US cities.  

Simply click on the layer name in the Table of Contents, hold the mouse button down, and slide it 
up or down. The map is redrawn with the new stacking order. Now we can see cities on top of the 
counties:
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1.2	A djusting Your View

Often you will want to zoom in on an area to see the kind of detail you need. For example, if you want 
to see the streets of your city, looking at a map of the whole United States wouldn’t be very useful. To 
look at a smaller area, you need to use the zoom tools.

Zooming in
To zoom in (enlarge a small area to see more detail), select the “Zoom In” tool ( ). When your 
cursor is over the map, it takes the shape of a small magnifying glass with a + symbol. 

The simplest way to zoom in on an area is to simply click on the area of interest. The map will zoom in 
and center the map on the point where you clicked.

Another approach that will give you more control is to envision a box around the area of interest. 
Using the “Zoom In” tool, click where you would like the upper left corner to be, hold the mouse 
button down, and drag down and to the right.   
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When the box encloses the area of interest, release the mouse button. The map will zoom into the area 
you chose:

Zooming out
To look at a larger area, click on the “Zoom Out” button ( ) and then click the map. Your view will 
zoom out, staying centered on where you clicked. 

The example below shows the previous map centered on Missouri after two clicks with the “Zoom 
Out” tool:
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Other zoom options
It takes some practice to master the “touch” needed to zoom efficiently. 

To go back to the last view you had, simply click the “Go Back to Previous Extent” button( ). 

If you are much too far in or out, it may be quicker to click the “Full Extent” button ( ). This will 
take you to a zoom level that is wide enough to include all of the data layers in the Table of Contents, 
whether they are turned on or not.

Another zoom option is to zoom to a level that shows the extent of a particular data layer. To do this, 
simply right-click on the map layer in the Table of Contents and choose “Zoom to Layer”:

Additionally, the “Zoom In on the Center of your Map” button ( ) and the “Zoom Out on the 

Center of your Map” button ( ), can also be used to quickly zoom in and out.
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 Tip

If you are not panning or zooming, it is a good idea to change from those tools to the 

“Select Elements” ( ) tool.  This helps you avoid accidentally shifting or zooming your map.

Panning
If you are satisfied with your zoom, but just need to “slide” the map a bit, use the “Pan” tool ( ). 

With the “Pan” tool selected, click anywhere on the map, and then—holding the mouse button down 
—slide the map into position.  Note: the new area you are panning to will not be displayed until you 
release the mouse button.
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1.3	 Editing the Legend

As you make maps, you will want to change the color of the map layers themselves, or change the 
shape, size, or color of the symbols. In many cases, color-coding parts of the map will help in your 
analysis. To make these changes, you will use the symbology controls within the layer’s properties. 

Changing symbology
To change a map layer’s symbology, in the Table of Contents double-click on the name of the layer you 
want to change. 

This will open the “Layer Properties” dialog box.

If it is not already selected, click on the “Symbology” tab.
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There are many things to control here; we will focus on only a few. First, we will change how the 
data is colored. In the example map, all states are currently as one color, or what ArcGIS calls “Single 
Symbol.” 

To change the US_STATES layer so that each state shows a different color:

Click on the “Categories” label on the left. 1)	

Choose “Unique Values” when that choice appears (in the “Categories” submenu).2)	

Using the dropdown arrow, choose “STATE_NAME” from the “Value Field”.3)	

Finally, click the “Add All Values” button to populate the small display box with the list of states 4)	
and the colors they are assigned.

If you’d like, you can choose a different color ramp. Your result of your choices is previewed in the 5)	
lower left side of the box.

When you are satisfied with your selection, you can click “OK”. The choices you made will take effect 
in the map and the dialog box will go away:

1¾ Step  ¾

2½ Step  ½

3¾ Step  ¾

4½ Step  ½

5½ Step  ½
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However, for later examples in this tutorial, keeping the states a single color may be a better choice. To 
return the states to a single color: 

Re-open the “Layer Properties” dialog box (by double-clicking on the “US_STATES” layer name 1)	
in the Table of Contents) .

In the “Symbology” tab, choose to show “Features” and then “Single Symbol”.2)	

Choose a color for the states by clicking on the colored box in the “Symbol” section.3)	

To finish, click “OK”.4)	
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So far we’ve looked at how to assign a single color to a layer and how to assign a unique color based 
on an attribute. Coloring by unique values is useful when you have descriptive data like names, 
but it can be confusing if you want to show the size or degree of something that is continuous (like 
temperatures, or in the case of hurricane data, the wind speed).

Color coding data
One of the most powerful tools you have for mapping your data is the ability to use colors to represent 
the data. This requires careful thought on your part as you make choices in how to display the data. 
For this example, I’ve added data for 2005’s Hurricane Katrina to the US states map by dragging the 
file from the Catalog window and dropping it into the data frame.

We will now color code the data based on wind speed. 

Open the “Layer Properties” box by double-clicking on the “katrina” layer name in the Table of 1)	
Contents. 
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In the “Symbology” tab, choose to show “Quantities” and then “Graduated Colors”. 2)	

For the “Value” field, choose “SPEED” to color code based on the magnitude of the earthquakes. 3)	

Change the color ramp if you prefer. 4)	

Click “OK” to have the changes take effect.5)	
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Another option to consider is to code the data with graduated symbols rather than graduated colors. 
You could use larger dots to signify greater wind speed, for example.
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Section 2: Downloading and Processing Data

2.1  Joining Data Tables

Many times you will find a table of data that you want to map, perhaps as an Excel spreadsheet or on 
a web page. If you have a shapefile that has the relevant geography, you can join the two pretty readily. 
For example, a table of data with crime statistics by zip code can be joined to a zip code shapefile, 
allowing you to map the data.

In this example, we will map the demographics of Shelby County (including Memphis), Tennessee.  
More information on how to access this kind of data is included on page 2.1.9.

Mapping the base shapefile
In ArcMap, create a new map.  Add the shapefile with the relevant geography—in this case a map of 
Shelby County, Tennessee—by dragging the file from the Catalog window to the data frame.  

If you’d like to see what data you have available in this shapefile, right-click on the layer name in the 
Table of Contents, and then click “Open Attribute Table.” 
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Notice that the table contains primarily just coding to identify each block group—nothing much of 
interest here:

You can close the Attribute Table window now.

Adding data from a table
If you have information in a table for the area you just mapped, you can add this data to your map.

Right-click the layer name in the Table of Contents.  Choose “Joins and Relates” from the popup 
menu, and then choose “Join” from the submenu. 
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In the first box in the Wizard that appears select “Join attributes from a table.”  

You are going to make the join based on columns that your base map layer and your data table 1)	
have in common.  In this example, we will choose the STFID column since this identifies each 
census block group in the country uniquely.

Click on the small folder icon and navigate to where you saved the table file. When you have 2)	
found the file, select it and click “Add.”

Next choose the field in the table that corresponds with the base layer’s field you chose in step 3)	
1.  In this case, the field is again called STFID, but the column headings don’t necessarily have to 
have the same names in both tables. The key is for each record in each table to match up one to 
one, regardless of what the columns are called.  (For example: one column might be called STFID 
and the other census_block_group_id.)

1» Step  »

2» Step  »

3» Step  »
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Click the “OK” button at the bottom and ArcMap will join the data for you. When asked, allow 
ArcMap to index the data.

If you right-click on the block group layer again and choose “Open Attribute Table,” you can see many 
fields of useful demographic data attached to the layer. 
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1» Step  »

2½ Step  ½

3¾ Step  ¾

4» Step  »

5» Step  »

Mapping the combined data
To map the demographic data, simply double-click the layer name in the Table of Contents to open 
the Layer Properties dialog box.

In the “Layer Properties” box:

Choose the “Symbology” tab1)	

In the “Show” section, click “Quantities” and then click “Graduated colors.”2)	

Now look at the “Fields” section.  In this case, I’m choosing fields from the dropdown menu so 3)	
the  map will show the Black population (tn_demog.BLACK), divided (normalized) by the total 
population within each block group (tn_demog.POP2000).

Under Classification I want five levels or 4)	 classes.

You can adjust the Color Ramp to whatever colors you desire. 5)	

Click “OK” close the dialog box and see the mapped data.  
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In this case, it shows distinctive segregation patterns:
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Saving the combined data as a shapefile
The data you just joined will not automatically be kept together; you need to make the join permanent 
by  making a new shapefile.  

Simply right-click on the original layer’s name in the Table of Contents, choose “Data” from the 
popup menu, and then “Export Data” in the sub-menu. 
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In the dialog box that appears, choose to export “All features” and use the same coordinate system as 
“this layer’s source data.”  Then choose a name and location for the new shapefile and click “OK.”
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Getting the data
You can map similar data for your county by downloading the data from http://arcdata.esri.com/
data/tiger2000/tiger_download.cfm. 

From this web page choose your state via the dropdown box or the map. On the next web page 
choose the county you want and click the “Submit Selection” button below the county dropdown 
box:

http://arcdata.esri.com/data/tiger2000/tiger_download.cfm
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Now you need to check the box or boxes next to the data layer or layers you want to download.  
Then click “Proceed to Download.”

For this example, I downloaded the block groups (this is a map of the county) for the year 2000 
and the SF1 demographics for block groups:

Once you have this data downloaded, unzip the zip files and save the extracted files somewhere 
easy to find.  You may want to rename the files to something more straightforward.  

In this case, I’ve changed the name of all block group files from “tgr47157grp00” to “tn_shelby_
cnty_map” since it is a map of Shelby County, Tennessee.  (All three files from this zip group 
must be changed to the same thing, without changing their file type extensions: .dbf, .shp, .shx.)  
And I renamed the “tgr47000sf1blk” file “tn_demog” since it is the demographic information 
for the entire state of Tennessee.
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2.2  Managing .e00 Files

Many times, the geospatial data you download will be in an export or interchange format. These are 
files that end in .e00. Please note that you will usually need to “unzip” files you download from the 
internet before processing them as described here. Zipped files typically end in a .zip or .gz. Thus, you 
could have filename.e00.gz to begin with. Unzip the file using any of a wide range of utilities designed 
for that purpose and you will be ready to proceed.

In this example, we will be preparing a road map for the city of St. Louis, Missouri. This was 
downloaded from the Missouri Spatial Data Information Service (http://msdis.missouri.edu/).  Once 
you have located and successfully downloaded (and unzipped, if necessary) your .e00 file, you need to 
perform at least one more step in processing it for use in ArcMap.

To process an .e00 file, open ArcToolbox by clicking on the icon ( ). 

In ArcToolbox, double-click on “Conversion Tools” and then double-click on “To Coverage.”  
Double-click “Import from E00.”

http://www.msdis.missouri.edu
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In the dialog box that appears, navigate to the .e00 file you downloaded earlier as the input file. 
Clicking on the folder icon will let you change your folder location to the one holding the .e00 file.

Similarly, navigate to the directory in which you want to place the output dataset, and assign a name 
for the file.  When this is done, you can click “OK” and the file will be converted to a coverage file that 
can be mapped. Note: there can be no spaces anywhere in the path names.

The new coverage will now be available for mapping in ArcMap. 

In ArcMap choose the file from the Catalog window. If you cannot find the new file, right-click on the 
output folder you used and click “Refresh.”  
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The file should now be visible.  Actually a number of files with the output name are now visible.  
Choose the one with the coverage icon ( ). Drag and drop it into the data frame.
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Converting the coverage into a shapefile
For ease of use, you may want to convert this coverage into a shapefile. A shapefile allows you to re-
project the data, and makes it easier to move the file around.

To make a shapefile, right-click on the layer name in the Table of Contents, choose “Data” from the 
popup menu, and then choose “Export Data” from the submenu:
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In the “Export Data” dialog box choose to export “All features” and then use the same coordinate 
system as “this layer’s source data.”  Finally select a location and file name for your new shapefile and 
click “OK.”
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2.3  Importing Imagery

You may want to add an aerial photograph or topographic map to your project.  We will look at two 
different sources and the way the imagery is imported for each.

Getting images from ArcGIS® Online
Many images can be brought in through ArcMap’s “File” menu. Open the File menu and then click on 
“ArcGIS Online.”
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This will open the ArcGIS Online window.  For this exercise, we are looking for an aerial photo of 
downtown St. Louis, Missouri.  Search for aerial images by typing the keyword “aerial” in the search 
box and clicking the magnifying glass icon. 

You should receive several pages of matches. You may need to scroll down or go to the next page to 
find the best file for your project.  Of the results shown, the “USA Imagery Map” selection towards the 
bottom of the first results page looks promising.  

Click on “Open” to get the imagery.  (Note: depending upon the size of the imagery files and your 
internet connection, it might take some time to download the imagery.)
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Now we’ve got the imagery, but we’re way too far out. You can add another map layer, like US_STATES 
to help you zoom in on your target area. You may get a dialog box like the one below if your two 
images do not share the same projection.
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ArcMap is usually pretty good about transforming the projection of the incoming file to match the 
base file, so we will click “Close.”

Adding the states helps us to zoom in on the area we are looking at.

When you are zoomed in enough you can turn off the visibility of the US_STATES layer by 
unchecking the box next to the file name in the Table of Contents. Then you can add the St. Louis city 
roads file if you like (this file was created in lesson 2.2).
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After some further zooming and fine-tuning we can see the downtown area of St. Louis with an 
overlay of the city streets.
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The site will return the choices available for that area.

Select one and it will appear in a window within the web site. Be sure to note how current the photo 
or topographic map is—quite often it can be a decade or more old, which may affect its usefulness.

Note that after your image or map is chosen, you can further navigate north, south, east, or west, and 
zoom in or out to alter the scope of your selection.

Getting images from Microsoft Research Maps
The Microsoft Research Maps web site (http://msrmaps.com) offers aerial photography and 
topographic maps for use in mapping projects. Both of these types of data are often called raster 
imagery. Following these steps will help you to locate and download the raster you need. 

First, at the Microsoft Research Maps site, at the upper left corner of the web page, enter a 
location for which you want an aerial photo or topographic map. Then click the “Go” button.  

http://msrmaps.com
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Once you have finalized your selection, click on the “Download” option in the top right corner of the 
image box. This engages processing on the server, preparing the photo for your use.

Once the photo is restored on screen, simply right-click on it and choose “Save picture as…” or a 
similar command for the browser you are using.

Save the image in JPG format (with the .jpg file ending; note: using the .jpeg ending will not work!)
in a location you will remember. Remember that ArcMap handles the Desktop and My Documents 
locations poorly. Pick another place if you can. It might be most helpful to put the new jpg file in a 
folder that is already connected to the Catalog through the “Folder Connections” utility (see page 
1.1.3).

Once you have saved your image, choose the “World File” option which has now appeared near the 
top right corner of the image box. 
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A series of numbers will appear in a new browser window. Copy and paste these numbers into a new 
Notepad file.  

Save the file with same file name you used for the image earlier, except now the ending must be “.jgw”.   
Be sure to change the “Save as type” selector to “All Files.”

These two files must be stored in the same folder.

Double-check that your two files have the same names and have the file endings .jpg and .jgw.  You can 
do this by navigating to the folder using Windows Explorer.  Before adding the photo to your project, 
be sure your world file was saved properly and that no extra file type ending was added after the .jgw. 
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In ArcMap, drag the image from the Catalog window and drop it into the data frame.  Add any other 
data you want.

(Note: Microsoft Research Maps files use NAD 83 UTM as their coordinate system. Look at the zone 
map available at http://www.tinyurl.com/UTMzones to see which zone you need. St. Louis, Missouri is 
in zone 15. Thus the projection for this image is NAD 83 UTM Zone 15N. The “N” stands for north 
because it is in the Northern hemisphere.)

Note: if you want to plot coordinates on an image, see section 4.4 for special projection instructions. 

http://www.tinyurl.com/UTMzones
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Section 3: Advanced Data Management

Occasionally, this doesn’t work, however, and a projection must be defined for one or more map layers. 

To do this, start ArcToolbox by clicking on the small toolbox icon ( ) in ArcMap.

Within ArcToolbox, double-click “Data Management Tools” to expand that menu, then double-click 
“Projections and Transformations,” and finally, double-click “Define Projection”:

3.1  Defining Map Projections

ArcMap generally does an adequate job of “projecting on the 
fly,” or making the necessary translations between different 
projections. This allows data from different projections to be 
mapped in the same project. When a projection is being done 
“on the fly,” you will receive a message like the one below, but in 
most cases the accuracy will be sufficient for your purposes.

What is a map projection?

A map projection is used 
to portray all or part of the 
round Earth on a flat surface. 
This cannot be done without 
some distortion.

Every projection has its 
own set of advantages and 
disadvantages. There is no 
“best” projection.

The mapmaker must select 
the one best suited to the 
needs, reducing distortion of 
the most important features.

From the USGS web page “Map 
Projections.”  (http://egsc.usgs.
gov/isb/pubs/MapProjections/
projections.html)

http://egsc.usgs.gov/isb/pubs/MapProjections/projections.html
http://egsc.usgs.gov/isb/pubs/MapProjections/projections.html
http://egsc.usgs.gov/isb/pubs/MapProjections/projections.html
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This opens a wizard that will guide you through the process. 

In the first box, navigate to the map layer (known formally as the dataset or feature class).  

In the second box you will specify the coordinate system.  (The coordinate system should be known or 
available from the source of the data. If not, you will need to contact the data provider.)  Sometimes the 
coordinate system will automatically fill in when you specify the map layer.  If it fills in for you, the 
projection is already assigned.  Click “Cancel” to close the dialog box.

If the coordinate system does not automatically fill in, you will have to specify it. Click on the icon ( ) 
to the right of the box. 
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The “Spatial Reference Properties” dialog box will pop up, and you can select one of three common 
options:



Mapping your community with ArcGIS® 10
Advanced Data Management—Defining Map Projections 3.1.4

10/23/2010

 1)	
If you opt to select the coordinate system, you will need to navigate to an appropriate geographic 
or projected coordinate system. At the risk of over-simplification, the geographic coordinate 
systems use a latitude / longitude system that assign every point on Earth a unique coordinate. 
In other instances, usually for maps covering a smaller area, projected systems are used. In either 
case, selecting the appropriate coordinate system is a matter of navigating through the folders to 
find the appropriate choice.

2)	
If you choose to import a projection already used by another shapefile, you will be prompted to 
locate the layer with the projection you want to use. When the data file has been located, simply 
double-click on it or click it and then click “Add.” This will assign the projection of the shapefile 
you just chose to the unprojected one.

3)	
If you need to define a new coordinate system not available in the selections covered in the first 
two options, you will need the relevant data from the data provider to complete the dialog box. 
(Note that this is very rarely needed; in almost all cases one of the other two options above is the 
right choice.)

Whichever of the three options you use, click “OK” when you have completed the “Spatial Reference 
Properties” dialog box.  Then click “OK” to close the “Define Projection” dialog box, and a projection 
will have been defined for the layer.
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3.2  Clipping Data Layers

Many times you will want to use a smaller part of a layer (like only the roads in one school district or 
town, not the whole county). This technique, called “clipping,” is pretty easy to use.

Clipping Out Part of a Layer
To clip out part of a layer, you actually need two layers: the one you are clipping and the one that 
provides the boundaries of the “clip.” 

In this example, we’ll clip out the roads for one school district from the larger county road layer. 
Metaphorically, the school district boundary will be the cookie cutter and the road layer the dough. If 
you need to make the cookie cutter first, see the suggestions on page 3.2.3.

Within ArcMap, open ArcToolbox by clicking on the small red toolbox icon (1)	 ).

In ArcToolbox, double-click “Analysis Tools,” double-click “Extract,” and finally double-click 2)	
“Clip.”  This will open a dialog box where you can choose the layers you need. 

10/31/2010
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In the “Clip” dialog box, choose the input features (the County Roads in this case) and the clip 3)	
features (the Kirkwood school district). If the layers aren’t already loaded into the project you are 
working on, you can navigate to them by clicking on the folder icons next to each feature.

Choose the name and location for the output layer.4)	

When you click “OK ,” ArcMap starts to make your clipped layer. The program will run the word 5)	
“Clip” across the bottom of the window while it is working. When the clipping is complete, close 
the dialog box and you will see your layer in ArcMap. 

10/31/2010

To zoom in on your new layer, right-click (in the Table of Contents) on the layer name and 6)	
choose “Zoom to Layer.”
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Making a Good “Clip Layer”
Many times you won’t have the specific area you are interested in as a separate layer ahead of time. 
In the example above, the Kirkwood School District clip layer started as a layer containing all of the 
school districts in St. Louis County, but with just a few quick steps we can create a new layer that only 
contains the Kirkwood district. 

If you have multiple layers on your map, be sure the one you want to clip is the one highlighted in 1)	
the Table of Contents.

There are several ways to make the clip layer:2)	

Option 1: Click on the A)	 Select Features tool ( ) from your tool palette. Click and drag a 
small box in the area you want to select.  Be sure your box does not go outside the boundaries 
of the area you want in your clip layer. The selected parts will be highlighted in cyan blue. If 
you accidentally select too much, you can go back to the Selection menu and choose “Clear 
Selected Features.” Then try your selection again.

10/31/2010
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Option 2: Alternately, you can select the area you want by using the B)	 Attribute Table.  To do 
this, right click on the layer name, and in the menu that appears select “Open Attribute Table.”  

10/31/2010

At the top of the Attribute Table, click on the “Select by Attributes” tool ( ).



Mapping your community with ArcGIS® 10
Advanced Data Management—Clipping Data Layers 3.2.5

In the dialog box that appears:

Choose “Create a new selection” as the Method.1)	

Double-click on “Name.”2)	

Single-click on the Equals button (3)	 ).

Click on the “Get Unique Values” button (4)	 ). This will populate                       
the box above it.

Double-click on “Kirkwood School District.”5)	

Click “Apply.”6)	

1» Step  »

2» Step  »
3» Step  »

4» Step  »

5» Step  »

6½ Step  ½
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Now that the Kirkwood School District is selected, it is shown on the map with a highlighted border. 3)	

In the Table of Contents, right-click on the layer containing the selected feature, and choose 4)	
“Data” and then “Export Data.” 



Mapping your community with ArcGIS® 10
Advanced Data Management—Clipping Data Layers 3.2.7

In the dialog box that appears, choose to export “Selected features.” Use the same coordinate sys-5)	
tem as “this layer’s source data.”  Then choose a name and location for your new file. ArcMap au-
tomatically calls the new file Export_Output.shp.  You should rename it to something that makes 
sense (although leave the .shp ending intact).  When you are finished renaming click “OK.”

10/31/2010

When asked, add the exported data to your project.6)	

You can then proceed with the clipping operation with the layer you just created.
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3.3  Merging Data Layers

There will be times when it will be useful to have more than one layer combined into a new layer. In 
this example, road layers from St. Louis city and county will be combined into one new layer.

Within ArcMap, open 1)	 ArcToolbox by clicking on the small red toolbox icon ( ).

In 2)	 ArcToolbox, double-click “Data Management Tools” and then double-click “General.” This will 
reveal a number of tools; double-click “Merge.”
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In the dialog box that appears, choose at least two input layers. To choose layers that have 3)	 already 
been added  to your project, click the small dropdown arrow next to the box.  Choose the layers 
from the list that appears. 

If you need input layers that are not part of your project you can choose them by clicking on the

folder icon ( ) and then navigating to the layers you need.

Give your new layer an appropriate name and location, using .shp as your file type.  Click “OK.”4)	
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The blue text at the bottom of the ArcMap window will tell you how far along in the merging 
process you are.  

When the merge is finished, you can use your new layer.
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Section 4:  Plotting Locations

For many projects you will want to plot individual street addresses on a map. There are several tech-
niques that can be used. 

4.1  Plotting Single Addresses on a Map

If you have an individual address that you simply want to pinpoint on a map, you can use the “Find” 
tool to have the ArcGIS software mark your desired location.

Once you have your street map displayed, choose the “Find” tool (1)	 ) .
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In the Find dialog box that appears, choose “Locations” from the tabs at the top of the box. 2)	

In the Address Locator pulldown menu, choose the “U.S. Streets Geocode Service” option.a)	
Enter the address you are interested in. Usually a street and zip code are sufficient. b)	
Click “Find.”c)	

Matches will appear at the bottom of the dialog box. Right-click the one you want and choose 3)	
“Add Point” ( ). 
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 This will place a small dot at the geocoded location. The dot will stay in the correct location as you 
zoom in and out or pan around the map.

This technique is easy to use for locating addresses, but it is limited in that you can only identify the 
location. There are no attributes with the dot that you can use to color code based on an attribute, like 
you can with most geospatial data.
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4.2  Preparing Multiple Addresses for Plotting on a Map

If you have several addresses to plot, you can simply repeat the directions in section 4.1 as many times 
as needed. This may be cumbersome if you have many addresses, however, and you are still limited to 
displaying a dot. A more powerful option is to use a batch geocoder that will process many addresses 
at once and give you more options once you have your points located.

To use this option, go online to www.gpsvisualizer.com/geocoder. From there, type in the addresses you 
are interested in geocoding:

Click the “Start Geocoding” button and, after a brief wait, your results will appear in a text file below a 
map of your points.  

http://www.gpsvisualizer.com/geocoder
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These points can then be plotted just as if they were GPS coordinates. (See section 4.3: Plotting GPS 
Coordinates, page 4.3.2.)

Copy and paste the results into Notepad or another text editor, and save the file as a comma separated 
value (.csv) file.  Be sure you switch the “Save as type” selector to “All Files.”
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4.3  Plotting GPS Coordinates

For many projects you will want to plot coordinates.  First you must set the projection of your map.

Setting the projection
Before plotting your GPS data, be sure that the projection of your map view has been set. To do this, go 
to the View menu and choose “Data Frame Properties.”

Within the dialog box that appears, choose the “Coordinate System” tab. In the box near the bottom 
of the dialog box, choose the coordinate system your map is using. In almost all cases this will be a 
“predefined” cooordinate system. 

Geographic Coordinate Systems •	 use latitude-longitude values. One good choice is WGS 1984 
(navigate to it by clicking Predefined > Geographic Coordinate Systems > World > WGS 1984).  

Projected Coordinate Systems•	  use x, y values.  Among Projected Coordinate Systems, both State 
Plane and UTM are very useful.  

The choice of projection is very dependent on the data you have and the location with which you are 
working.  For our purposes, set the projection to WGS 1984 (Predefined > Geographic Coordinate 
Systems > World > WGS 1984) unless you know your data is in a different projection.

(Note: when combining imagery, such as aerial photos, with coordinates, special instructions apply. 
See section 4.4.)

When the coordinate system has been selected, click “Apply” and then “OK.”

You can then return to the main ArcMap interface to map your points. 
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After you have set the projection for your map, put the coordinates (from a GPS receiver or other data 
source) into a table. 

You can use Notepad or any other simple text editor to do this.  In the first line type in the data 
headings separated by commas.  Type the data in subsequent lines in the same order as the headings, 
again separated by commas:

After you have entered your data, save the file as a comma separated value (.csv) file.  Be sure to 
switch the “Save file type” selector to “All files.”
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Within ArcMap, make the base map as you normally would, with whatever layers of data are 
appropriate. Then, from the File menu, choose “Add Data” then “Add XY Data.”  

In the dialog box that appears, click the small folder icon ( ).  Navigate to where you have saved the 
.csv file, select it, and click “Add.”

You should see that the file has been selected, and ArcGIS has made an effort to identify the X and Y 
coordinates of your data:
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You will see your points plotted on your map:

Click “OK”

If you get an error box about the table not having an Object-ID field, click “OK.”

Notice that your new points appear in the Table of Contents (to the left of the map) as an event. To 
be able to edit this layer later, you will want to make it into a “regular” data layer. You can do this by 
exporting it to a shapefile (see page 4.3.5). 
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Exporting to a shapefile
Right-click the layer in the Table of Contents, choose “Data” from the popup menu, then select “Export •	
Data” from the submenu.
Click the “Export” drop-down arrow and select “All features”•	
Select the output coordinate system you want to use. (In this case we will use “this layer’s source data”.) •	

Click the Browse folder icon (•	 ) to navigate to a location to save the exported shapefile.  Name your 
file and save it as a shapefile (.shp).  Then click “OK.” 
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4.4  Combining Imagery and Coordinates

Sometimes you will want to map both coordinates and an image.  Getting the projections of the two 
to work together can be a challenge.  This tutorial will walk you through one way to map the data.  

Getting the image set up
First, open ArcMap and begin a new map.

Drag the image you want to map (such as an aerial photo) from the Catalog window into the data 
frame. (Instructions on finding, preparing, and downloading aerial photographs and topographic maps 
can be found in the section on importing imagery: 2.3.4.)

In the example, an aerial photo of Ladue, Missouri was added.  

Next, we need to set the projection. To do this, open the “View” menu and then click “Data Frame 
Properties.”
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In the “Data Frame Properties” dialog box that appears, go to the “Coordinate System” tab.

Here select whatever coordinate system was used by the image.  For the example, knowing that the 
coordinate system for the image is NAD 1983 UTM Zone 15N, choose:

Predefined  >  Projected Coordinate Systems   >   UTM   >  NAD 1983  >  NAD 1983 UTM Zone 15N

Click “OK” to set the coordinate system, close the box, and return to the map
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Adding the coordinates
From the “File” menu click “Add Data” then “Add XY Data.”

In the dialog box that appears, click on the folder icon ( ) and navigate to the .csv file you want to 
use.  (Instructions on saving coordinates as a .csv file can be found at 3.3.1.)

The X Field and Y Field sections should fill themselves in with Longitude and Latitude respectively:
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Click “OK.”  

You may get an error box that your table does not have an Object-ID field.  We will fix that in a 
moment.  Click “OK” to close the error box.

Create a shapefile from the coordinate data
Right-click the .csv file name in the Table of Contents, then click “Data” and “Export Data…”
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When asked, add the new shapefile to your map as a layer:

In the “Export Data” dialog box that appears, choose to export “All features” and use the same 
coordinate system as “this layer’s source data.”  Select a file location and name for your new shapefile 
and click “OK.”

Back at your map, right-click on the .csv file name in the Table of Contents and then click “Remove.”



Mapping your community with ArcGIS® 10
Plotting Locations—Combining Imagery and Coordinates 4.4.6

10/24/2010

Setting the projection of the new shapefile
Open ArcToolbox by clicking on the ArcToolbox icon ( ).

In ArcToolbox double-click on “Data Management Tools” then double-click “Projections and 
Transformations.”  Finally double-click “Define Projection.”
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In the “Define Projection” dialog box, use the drop-down arrow or the click the folder icon ( ) next 
to the “Input Dataset…” box to navigate to the file for which you want to define projection (in this 
case the new shapefile “GPS_points”).  

Then click on the  icon next to the “Coordinate System” box.  In the dialog box that appears, click 
the “Select” button.  Then double-click:

Geographic coordinate system  >  World  >  WGS 1984.prj

Click “OK.” 

Your “Define Projection” box should look like this:

Click “OK.” 

After a moment, the coordinates will appear in the correct location on your map:
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